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1 INTRODUCTION TO KEPLER 
 

Scientists in a variety of disciplines (e.g., biology, ecology, astronomy) need access to scientific data and 
flexible means for executing complex analyses on those data. Such analyses can be captured as scientific 
workflows in which the flow of data from one analytical step to another is captured in a formal workflow 
language. The Kepler projectΩs overall goal is to produce an open-source scientific workflow system that 
allows scientists to design scientific workflows and execute them efficiently either locally or through 
emerging Grid-based approaches to distributed computation.  

 

1.1 WHAT IS KEPLER? 
 

Kepler is a software application for the analysis and modeling of scientific data. Using KeplerΩs graphical 
interface and components, scientists with little background in computer science can create executable 
scientific workflows, which are flexible tools for accessing scientific data (streaming sensor data, medical 
and satellite images, simulation output, observational data, etc.) and executing complex analysis on the 
retrieved data (Figure 1.1).   
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FIGURE 1.1: A SCIENTIFIC WORKFLOW (GARP_SINGLESPECIES_BESTRULESET-IV.XML) DISPLAYED IN THE KEPLER INTERFACE. THIS 

WORKFLOW PROCESSES SPECIES OCCURRENCE DATA TO CREATE AN ECOLOGICAL NICHE MODEL. 

 

Kepler includes distributed computing technologies that allow scientists to share their data and workflows 
with other scientists and to use data and analytical workflows from others around the world. Kepler also 
provides access to a continually expanding, geographically distributed set of data repositories, computing 
resources, and workflow libraries (e.g., ecological data from field stations, specimen data from museum 
collections, data from the geosciences) (Figure 1.2). 
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FIGURE 1.2: A WORKFLOW (EML-SIMPLE-LINEARREGRESSION-R.XML) THAT PERFORMS AND PLOTS A SIMPLE LINEAR REGRESSION 

ON A METEOROLOGICAL DATA SET STORED REMOTELY ON THE EARTHGRID AND ACCESSED VIA A WORKFLOW ACTOR. 

 

The Kepler system aims at supporting very different kinds of workflows, ranging from low-level άǇƭǳƳōƛƴƎέ 
workflows of interest to Grid engineers, to analytical knowledge discovery workflows for scientists (Figure 
1.3), and conceptual-level design workflows that might become executable only as a result of subsequent 
refinement steps.1 

 

                                                                 
1 Ludäscher, B., I. Altintas, C. Berkley, D. Higgins, E. Jaeger-Frank, M. Jones, E. Lee, J. Tao, Y. Zhao. 2005. 
Scientific Workflow Management and the Kepler System, DOI: 10.1002/cpe.994  
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FIGURE 1.3: THE PROMOTER IDENTIFICATION WORKFLOW, A TYPICAL SCIENTIFIC KNOWLEDGE DISCOVERY WORKFLOW THAT 

LINKS GENOMIC BIOLOGY TECHNIQUES SUCH AS MICROARRAYS WITH BIOINFORMATICS TOOLS SUCH AS BLAST TO IDENTIFY AND 
CHARACTERIZE EUKARYOTIC PROMOTERS. 

 

Kepler builds upon the mature Ptolemy II framework, developed at the University of California, Berkeley. 
Other scientific workflow environments include academic systems such as SCIRun, Triana, Taverna, and 
commercial systems (Scitegic/Pipeline-Pilot, Inforsense/Accelrys).2 For a detailed discussion of these and 
other workflow systems, please see http://www.gridbus.org/reports/GridWorkflowTaxonomy.pdf.  

 

1.1.1 FEATURES 
 

Using Kepler, scientists can capture workflows in a format that can easily be exchanged, archived, 
ǾŜǊǎƛƻƴŜŘΣ ŀƴŘ ŜȄŜŎǳǘŜŘΦ .ƻǘƘ YŜǇƭŜǊΩǎ ƛƴǘǳƛǘƛǾŜ D¦L όƛƴƘŜǊƛǘŜŘ ŦǊƻƳ tǘƻƭŜƳȅύ ŦƻǊ ŘŜǎƛƎƴ ŀƴŘ ŜȄŜŎǳǘƛƻƴΣ ŀƴŘ 
its actor-oriented modeling paradigm make it a very versatile tool for scientific workflow design, 
prototyping, execution, and reuse for both workflow engineers and end users. Kepler workflows can be 

                                                                 
2 Altintas, I, C. Berkley, E. Jaeger, M. Jones, B. Ludäscher, S. Mock, Kepler: An Extensible System for Design 
and Execution of Scientific Workflows, system demonstration, 16th Intl. Conf. on Scientific and Statistical 
Database Management (SSDBM'04), 21-23 June 2004, Santorini Island, Greece.   

http://ptolemy.eecs.berkeley.edu/ptolemyII
http://software.sci.utah.edu/scirun.html
http://www.trianacode.org/
http://www.taverna.org.uk/
http://accelrys.com/
http://www.gridbus.org/reports/GridWorkflowTaxonomy.pdf
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ŜȄŎƘŀƴƎŜŘ ƛƴ ·a[ ǳǎƛƴƎ tǘƻƭŜƳȅΩǎ ƻǿƴ aƻŘŜƭƛƴƎ aŀǊƪǳǇ [ŀƴƎǳŀƎŜ όaƻa[ύΦ YŜǇƭŜǊ ŎǳǊǊŜƴǘƭȅ ǇǊƻǾƛŘŜǎ ǘƘŜ 
following features: 3 

 

Access to Scientific Data: The Kepler component library contains an Ecological Metadata Language (EML) 
ingestion actor (EML2Dataset) used to access, download, and preview EML described data sources. The 
EML2Dataset actor allows Kepler to import a multitude of heterogeneous data, making it a very flexible 
tool for scientists who often deal with many data and file formats. A similar actor exists for Darwin Core-
described data sets (DarwinCoreDataSourceύΦ Lƴ ŀŘŘƛǘƛƻƴΣ YŜǇƭŜǊΩǎ ReadTable actor allows users to access 
and incorporate data stored in Excel spreadsheets4. 

 

Graphical User Interface: Users can build workflows Ǿƛŀ YŜǇƭŜǊΩǎ ƛƴǘǳƛǘƛǾŜ ƎǊŀǇƘƛŎŀƭ ƛƴǘŜǊŦŀŎŜΦ /ƻƳǇƻƴŜƴǘǎ 
are dragged and dropped onto a Workflow canvas, where they can be connected, customized, and then 
executed.  

 

Distributed Execution (Web and Grid {ŜǊǾƛŎŜǎύΥ YŜǇƭŜǊΩǎ Web and Grid service actors allow scientists to 
ǳǘƛƭƛȊŜ ŎƻƳǇǳǘŀǘƛƻƴŀƭ ǊŜǎƻǳǊŎŜǎ ƻƴ ǘƘŜ ƴŜǘ ƛƴ ŀ ŘƛǎǘǊƛōǳǘŜŘ ǎŎƛŜƴǘƛŦƛŎ ǿƻǊƪŦƭƻǿΦ YŜǇƭŜǊΩǎ ƎŜƴŜǊƛŎ WebService 
actor provides the user with an interface to seamlessly plug in and execute any WSDL-defined Web service. 
In addition to generic Web services, Kepler also includes specialized actors for executing jobs on the Grid, 
e.g., actors for certificate-based authentication (SProxy or GlobusProxy), Grid job submission (GlobusJob), 
and Grid-based data access (GridFTP). Third-party data transfer on the Grid can be established using GridFTP 
and SRB (Storage Resource Broker) actors. 

 

Prototyping Workflows: Kepler allows scientists to prototype workflows before implementing the actual 
ŎƻŘŜ ƴŜŜŘŜŘ ŦƻǊ ŜȄŜŎǳǘƛƻƴΦ YŜǇƭŜǊΩǎ Composite actor can be used ŀǎ ŀ άōƭŀƴƪ ǎƭŀǘŜέ that prompts the 
scientist for critical information about an actor, ŜΦƎΦΣ ǘƘŜ ŀŎǘƻǊΩǎ ƴŀƳŜ and port information.  

 

Searchable Libraries: Kepler has a searchable library of actors and data sources (found under the 
Components and Data tabs of the application) with numerous reusable Kepler components and an ever-
growing collection of data sets. 

 

Database Access and Querying: Kepler includes (JDBC-compliant) database actors, such as the DBConnect 
actor, which emits a database connection token (after user login) to be used by any downstream DBQuery 
actor that needs it. 

 

Other Execution Environments: Supporting foreign language interfaces via the Java Native Interface (JNI) 
gives the user flexibility to reuse existing analysis components and to target appropriate computational 
tools. For example, Kepler (through Ptolemy) already includes a Matlab actor. Actors that execute R code 
(RExpression, Correlation, RMean, RMedian, and others) are also included in the standard actor library. Any 
application that can be executed on the command line can also be executed by the Kepler 
CommandLineExec actor. 

 

Data Transformation: Kepler includes a suite of data transformation actors (XSLT, XQuery, Perl, etc.) for 
linking semantically compatible but syntactically incompatible Web services together.  

 

                                                                 
3 Ibid. 
4 The Excel spreadsheets must be saved as delimited text files. 
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Flexible Execution: Kepler workflows can be executed in batch mode from the command line or a web 
service. Additionally, the BrowserUI actor can inject user control and input anywhere in a workflow via the 
ǳǎŜǊΩǎ Web browser.  

 

Configurable Libraries: Users can configure their own actor libraries via a semantic type interface, or 
download (and upload) additional actors from the Kepler repository. 

 

1.1.2 ARCHITECTURE 
 

Kepler builds upon the mature Ptolemy II framework, developed at the University of California, Berkeley. 
Ptolemy II is a software framework developed as part of the Ptolemy project, which studies modeling, 
simulation, and design of concurrent, real-time, embedded systems. Kepler 2.5 is based on Ptolemy II 9.1. 

 

Kepler inherits from Ptolemy the actor-oriented modeling paradigm that separates workflow components 
(άactorsέ) from the overall workflow orchestration (conducted by άdirectorsέ), making components more 
easily reusable. Through the actor-oriented and hierarchical modeling features built into Ptolemy, Kepler 
scientific workflows can operate at very different levels of granularity, from low-level άplumbing workflowsέ 
(that explicitly move data around or start and monitor remote jobs, for example) to high-level άconceptual 
workflowsέ (that interlink complex, domain-specific data analysis steps). Kepler also inherits modeling and 
design capabilities from Ptolemy, including the Vergil graphical user interface and workflow scheduling and 
execution capabilities.  

Kepler extensions to Ptolemy include an ever increasing number of components (called άactorsέ) aimed 
particularly at scientific applications: remote data and metadata access, data transformations, data 
analysis, interfacing with legacy applications, Web service invocation and deployment, and provenance 
tracking, among others. Target application areas include bioinformatics, computational chemistry, 
ecoinformatics, and geoinformatics.  

 

PTOLEMY/VERGIL (A VERY BRIEF OVERVIEW) 
 

Ptolemy II, developed at the University of California, Berkeley, is an open-source software framework 
developed as part of the Ptolemy project. Ptolemy II is a Java-based component assembly framework with 
a graphical user interface called Vergil.  

 

The Ptolemy project studies modeling, simulation, and design of concurrent, real-time, embedded systems. 
The focus is on embedded systems, particularly those that mix technologies including, for example, analog 
and digital electronics, hardware and software, and electronics and mechanical devices. The focus is also 
on systems that are complex in the sense that they mix widely different operations, such as networking, 
signal processing, feedback control, mode changes, sequential decision making, and user interfaces.5 

 

                                                                 
5 Hylands, Christopher, Edward Lee, Jie Liu, Xiaojun Liu, Stephen Neuendorffer, Yuhong Xiong, Yang Zhao, 
Haiyang Zheng, Ptolemy Overview, 
http://www.ptolemy.eecs.berkeley.edu/publications/papers/03/overview/overview03.pdf 

http://ptolemy.eecs.berkeley.edu/ptolemyII
http://ptolemy.eecs.berkeley.edu/
http://www.ptolemy.eecs.berkeley.edu/publications/papers/03/overview/overview03.pdf
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Ptolemy II takes a component-based view of design, in that models are constructed as a set of interacting 
components. A model of computation governs the semantics of the interaction, and thus imposes a 
discipline on the interaction of components.6 

 

Ptolemy II offers a unified infrastructure for implementations of a number of models of computation. The 
overall architecture consists of a set of packages that provide generic support for all models of computation 
and a set of packages that provide more specialized support for particular models of computation. 

 

Examples of the former include packages that contain math libraries, graph algorithms, an interpreted 
expression language, signal plotters, and interfaces to media capabilities such as audio. Examples of the 
latter include packages that support clustered graph representations of models, packages that support 
executable models, and domains, which are packages that implement a particular model of computation.7 

 

The Vergil GUI is a visual editor, written in Java. Using Vergil, users can graphically construct and run 
scientific workflows. For more information about Vergil, see the Ptolemy documentation. 

 

MODELING MARKUP LANGUAGE (MOML) 
 

Modeling Markup Language (MoML), the primary persistent file format for Ptolemy II models, is an 
Extensible Markup Language (XML) schema. It is intended for specifying interconnections of parameterized 
components, and is the primary mechanism for constructing models whose definition and execution is 
distributed over the network.8 

 

The key features of MoML include:9 

 

ω Web integration: MoML is an XML schema intended for use on the Internet. File references are via URIs 
(in practice, URLs), both relative and absolute, so MoML is equally comfortable working in applets and 
applications. 

 

ω Implementation independence: MoML is designed to work with a variety of modeling tools.  

 

ω Extensibility: Components can be parameterized in two ways. First, they can have named properties with 
string values. Second, they can be associated with an external configuration file that can be in any format 
understood by the component. Typically, the configuration will be in some other XML schema, such as 
PlotML or SVG (scalable vector graphics). 

 

ω Classes and inheritance: Components can be defined in MoML as classes which can then be instantiated 
in a model. Components can extend other components through an object-oriented inheritance mechanism. 

 

                                                                 
6 Ibid. 
7 Ibid. 
8 Ptolemy User Manual, http://www.eecs.berkeley.edu/Pubs/TechRpts/2007/EECS-2007-7.pdf 
9 Ibid. 

http://www.eecs.berkeley.edu/Pubs/TechRpts/2007/EECS-2007-7.html
http://www.eecs.berkeley.edu/Pubs/TechRpts/2007/EECS-2007-7.pdf
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ω Semantics independence: MoML defines no semantics for an interconnection of components. It 
represents only the hierarchical containment relationships between entities with properties, their ports, 
and the connections between their ports. In Ptolemy II, the meaning of a connection (the semantics of the 
model) is defined by the director for the model, which is a property of the top level entity. The director 
defines the semantics of the interconnection. MoML knows nothing about directors except that they are 
instances of classes that can be loaded by the class loader and assigned as properties. 

 

For detailed information about MOML and its syntax, please see the Ptolemy user manual, Chapter 7. 

 

1.2 HISTORY OF THE KEPLER PROJECT 
 

Kepler was founded in 2002 by researchers at the National Center for Ecological Analysis and Synthesis 
(NCEAS) at University of California Santa Barbara, the San Diego Supercomputer Center (SDSC) at University 
of California San Diego, and the University of California Davis as part of the Science Environment for 
Ecological Knowledge (SEEK) and Scientific Data Management (SDM) projects. 

The Kepler software extends the Ptolemy II system developed by researchers at the University of California 
Berkeley.  Although not originally intended for scientific workflows, Ptolemy II provides a mature platform 
for building and executing workflows, and supports multiple models of computation.  

Kepler has had many releases: 

¶ Alpha, April 2005. 

¶ Beta 1, June 2006. 

¶ Beta 2, July 2006. 

¶ Beta 3, January 2007. 

¶ 1.0, May 2, 2008.  

¶ 2.0.0, June 2010, major improvements to the GUI, modular design and KAR (Kepler Archive Format) 
handling. 

¶ 2.1.0, September 30, 2010. 

¶ 2.2.0, June 14, 2011. 

¶ 2.3.0, January 20, 2012. 

¶ 2.4.0, April 5, 2013. 

¶ 2.5.0, October 28, 2015. 

Kepler is an open collaboration with many contributors from diverse domains of science and engineering, 
including ecology, evolutionary biology, molecular biology, geology, chemistry, computer science, electrical 
engineering, oceanography, and others. Members from the following projects are currently contributing to 
the Kepler project:  

¶ SEEK: Science Environment for Ecological Knowledge 

¶ SDM Center/SPA: SDM Center/Scientific Process Automation  

¶ Ptolemy II: Heterogeneous Modeling and Design  

¶ GEON: Cyberinfrastructure for the Geosciences  

¶ ROADNet: Real-time Observatories, Applications, and Data Management Network  

¶ EOL: Encyclopedia of Life  

¶ Resurgence 

¶ CIPRes: CyberInfrastructure for Phylogenetic Research  

¶ REAP: Realtime Environment for Analytical Processing  

¶ Kepler/CORE: Development of a Comprehensive, Open, Reliable, and Extensible Scientific 
Workflow Infrastructure 

¶ CAMERA: Community Cyberinfrastructure for Advanced Microbial Ecology Research & Analysis 

http://www.eecs.berkeley.edu/Pubs/TechRpts/2007/EECS-2007-7.html
http://www.nceas.ucsb.edu/#in_browser
http://www.nceas.ucsb.edu/#in_browser
http://www.sdsc.edu/#in_browser
http://ucdavis.edu/#in_browser
http://seek.ecoinformatics.org/#in_browser
http://sdm.lbl.gov/sdmcenter/#in_browser
http://ptolemy.eecs.berkeley.edu/#in_browser
http://seek.ecoinformatics.org/
https://sdm.lbl.gov/sdmcenter/
http://ptolemy.eecs.berkeley.edu/ptolemyII/
http://www.geongrid.org/
http://roadnet.ucsd.edu/
http://www.eol.org/
http://ocikbws.uzh.ch/resurgence/
http://www.phylo.org/
http://reap.ecoinformatics.org/
https://kepler-project.org/users/projects-using-kepler-1/kepler-core-vision-and-mission/
https://kepler-project.org/users/projects-using-kepler-1/kepler-core-vision-and-mission/
http://camera.calit2.net/
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¶ bioKepler: A Comprehensive Bioinformatics Scientific Workflow Module for Distributed Analysis of 
Large-Scale Biological Data 

¶ WIFIRE: A Scalable Data-Driven Monitoring, Dynamic Prediction and Resilience Cyberinfrastructure 
for Wildfires 

¶ NBCR: National Biomedical Computation Resource 

¶ BBDTC: Biomedical Big Data Training Collaborative 

¶ IPPD: Integrated End-to-End Performance Prediction and Diagnosis for Extreme Scientific 
Workflows 

 

Contributing members jointly determine the goals for Kepler as well as contribute to the design and 
implementation of the software system. We welcome contributions and encourage other people and 
projects to join as contributing members.  For more information about contributing to Kepler, please see 
Section 1.5. 

 

Some Kepler members receive support from various grants, including but not limited to: the National 
Science Foundation under awards 0225676 for SEEK, 0225673 (AWSFL008-DS3) for GEON, 0619060 for 
REAP, 0722079 for Kepler/CORE, 1062565 for bioKepler, 0941692 for DISCOSci, and 1331615 for WIFIRE; 
by the National Institutes of Health P41 GM103426 for NBCR and R25 GM114821 for BBDTC; by the Gordon 
and Betty Moore Foundation award to Calit2 at UCSD for CAMERA; by the Department of Energy under 
Contract No. DE-FC02-01ER25486 for SciDAC/SDM and DE-SC0012630 for IPPD. 

 

Work was conducted with logistical support from the National Center for Ecological Analysis and Synthesis 
(a Center funded by NSF Grant #DEB-0553768), the University of California Santa Barbara, and the State of 
California. 

 

The Center for Hybrid and Embedded Software Systems (CHESS) at UC Berkeley, is supported by Denso, IHI, 
National Instruments, and Toyota, and was previously supported by Agilent, Bosch, General Motors, 
Hewlett-Packard, HSBC, Infineon, Lockheed Martin, Microsoft, and Thales. The TerraSwarm Research 
Center, one of six centers administered by the STARnet phase of the Focus Center Research Program (FCRP) 
a Semiconductor Research Corporation program is sponsored by MARCO and DARPA. The iCyPhy Research 
Center (Industrial Cyber-Physical Systems), is supported by IBM and United Technologies, and was 
previously supported by The Multiscale Systems Center (MuSyC), one of six research centers funded under 
the Focus Center Research Program, a Semiconductor Research Corporation program. 

 

Ptolemy is supported by the Defense Advanced Research Projects Agency (DARPA) (TerraSwarm and 
MuSyC, see above), the National Science Foundation under awards 1446619 (Mathematical Theory of CPS), 
1329759 (COSMOI), and 0931843 (ActionWebs), and previous awards: #0720882 (CSR-EHS: PRET), and 
#1035672 (CPS: Medium: Timing Centric Software) and previously by the Air Force Research Laboratory 
under agreement numbers FA8750-08-2-0001 and FA8750-11-C-0023, the Army Research Laboratory under 
Cooperative Agreement Numbers W911NF-07-2-0019 and W911NF-11-2-0038, and the Naval Research 
Laboratory (NRL #N0013-12-1-G015). 

 

1.3 KEPLER CONTRIBUTORS 
 

The following people (in chronological order) have made contributions to the Kepler code and 
documentation: 

http://biokepler.org/
http://biokepler.org/
http://wifire.ucsd.edu/
http://wifire.ucsd.edu/
http://nbcr.ucsd.edu/wordpress2/
https://biobigdata.ucsd.edu/
http://hpc.pnl.gov/IPPD
http://hpc.pnl.gov/IPPD
http://chess.eecs.berkeley.edu/#in_browser
http://www.terraswarm.org/#in_browser
http://www.terraswarm.org/#in_browser
http://www.icyphy.org/#in_browser
http://www.icyphy.org/#in_browser
http://www.nsf.gov/#in_browser
https://www.collectiveip.com/grants/NSF:1446619#in_browser
http://chess.eecs.berkeley.edu/cosmoi#in_browser
http://chess.eecs.berkeley.edu/actionwebs#in_browser
http://chess.eecs.berkeley.edu/pret#in_browser
http://chess.eecs.berkeley.edu/ptides#in_browser
http://www.nrl.navy.mil/#in_browser
http://www.nrl.navy.mil/#in_browser
http://chess.eecs.berkeley.edu/spfsos#in_browser
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Matthew Jones Chad Berkley Ilkay Altintas 

Zhengang Cheng Efrat Frank Bertram 
Ludaescher 

Jing Tao Steve Mock Xiaowen Xin 

Dan Higgins Yang Zhao Christopher 
Brooks 

Tobin Fricke Rod Spears Werner Krebs 

Shawn Bowers Laura Downey Wibke Sudholt 

Timothy McPhillips Bing Zhu Nandita Mangal 

Jagan Kommineni Jenny Wang John Harris 

Kevin Ruland Matthew Brooke Oscar Barney 

Vitaliy Zavesov Zhije Guan Norbert 
Podhorszki 

Samantha Katz Tristan King Josh Madin 

Kirsten Menger-Anderson Edward Lee Daniel Crawl 

Derik Barseghian Lucas Gilbert Nathan Potter 

Ben Leinfelder Carlos Rueda Jim Regetz 

Sean Riddle Aaron Schultz David Welker 

Mark Schildhauer Debi Staggs Jianwu Wang 

Sven Koehler Faraaz Sareshwala Daniel Zinn 

Madhusudan Gujral Chandrika Sivaramakrish Lei Dou 

Merve Ildeniz Anatoly Loy Gongjing Cao 

Anand Kulkarni Manish Anand Marcin 
Plociennik 

Tomasz Zok Paul J. Morris Michal Owsiak 

Tianhong Song Shweta Purawat Charles Cowart 

Mai Nguyen Alok Singh  

 

Contributions to Kepler are welcome.  Please see Section 1.5 for details on how to contribute. Thanks! 

 

1.4 FUTURE GOALS 
 

The Kepler project is an ongoing collaboration, and we will continue to refine, release, and support the 
Kepler software. Our aim is to improve and enhance the Kepler scientific workflow system to yield a 
comprehensive, open, reliable, and extensible scientific workflow infrastructure suitable for serving a wide 
variety of scientific communities. 

 

The goal of future Kepler development is to (i) enable multiple groups in a number of distinct disciplines to 
easily create, support, and make available domain-specific Kepler extensions; (ii) better support those 
crucial features that are needed by all disciplines; and (iii) provide for the wide range of deployment 
scenarios required by different disciplines and distinct research settings.  
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More specifically, future goals include making Kepler: 

 

Independently Extensible: Rather than enforcing conventions that might slow progress in the various 
disciplines contributing to Kepler, we plan to further enable independent extensibility of Kepler while 
making it easy to package domain-specific contributions in a way that ensures both the stability of the 
overall system and clearly indicates what components are expected to work well together.  

 

With the 2.0 release of Kepler, we have created a module system that allows us to separate Kepler base 
system functionality from domain-specific extensions.  We have divided Kepler into a set of mandatory 
modules (the kepler suite); a set of extension modules that communicate with the kernel via well-defined 
and generic extension interfaces; and a number of actor modules for distinct disciplines. We developed a 
configuration management system to support downloading, installing, and updating the Kepler distribution 
and a Module Manager for discovering and installing standard and 3rd-party modules and specifying 
modules to be employed during execution. With this architecture, third-parties can now develop alternative 
modules with additional capabilities suitable for particular science domains. 

 

Consistently Reliable: Reliability for developers and users alike ensures that Kepler can be applied 
confidently as dependable cyberinfrastructure. We are working to ensure run-time reliability (both for 
when Kepler is used as a desktop research application and as middleware that other domain-specific 
applications can build upon). Our approach of dividing Kepler into the Kepler kernel and extension set will 
enable other development teams to freely develop new modules and actor packages as needed without 
endangering the stability of the kernel, and even to replace standard extensions as needed. 

 

Open Architecture, Open Project: We will disseminate plans, designs, and system documentation as we 
develop them and provide mechanisms for suggestions and feedback throughout the course of the project. 
We will also actively engage the user community and gather requirements, advice, and feedback on 
priorities, both from those already ŎƻƳƳƛǘǘŜŘ ǘƻ ǳǎƛƴƎ YŜǇƭŜǊ όƛΦŜΦΣ ǘƘŜ YŜǇƭŜǊ άǎǘŀƪŜƘƻƭŘŜǊǎέύΣ ŀƴŘ ŦǊƻƳ 
scientists who could benefit. 

 

Comprehensive (End-to-End) System: We plan to widen the scope of Kepler by providing new, fundamental 
enhancements that will benefit all user communities: enhancing Kepler with new and improved generic 
capabilities for data, service, and workflow management. More specifically, we are working on new and 
more comprehensive systems for: 

 

¶ Data Management: We plan to support data management tasks in a generic way within the Kepler 
framework so that all data management tasks (e.g., controlling and managing the flow of data into 
and out of workflows, comparing and visualizing data and metadata, converting data formats, and 
managing data references) are handled transparently by the workflow execution framework rather 
than by special-purpose actors. 

 

¶ External Service and Grid Management: Currently, Kepler workflows that make extensive use of 
external services generally use actor-oriented approaches for managing and accessing those 
services. We are working to better enable the system to carry out computations on the optimal 
set of computing resources at run time, based on resource availability and preferences; and to 
make it easier for users to share and redeploy workflows in different environments. In addition, 
we are working on integrated support for managing authentication and authorization information. 
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¶ Workflow Management: Our goal is for Kepler to provide comprehensive support for end-to-end 
workflow managementτfrom initial prototyping to workflow execution. We are working to make 
the application aware of the scientific context in which workflows are being run, the flow of data 
through and across successive workflows (as is common in scientific research), and the origin of 
workflows. In addition, we will continue to improve support for common workflow management 
tasks such as designing, storing, and validating individual workflows; organizing workflows, data, 
and results within the context of a particular project or research study; and capturing and querying 
the provenance of workflows and data. The Kepler workflow-run-manager and provenance 
modules will provide a whole new suite of functionality for managing workflows. 

 

Please see the Kepler/CORE Web page for detailed information about specific features that are under 
development, and/or the Bug base for more features that we are adding and improving in the coming 
months. 

 

1.5 PARTICIPATING IN KEPLER DEVELOPMENT 
 

Kepler is an open source cross-project collaboration, and we welcome contributions of all types. 
Participants can get involved by joining a mailing list (either for developers or users), participating in IRC 
chat, or getting a Kepler SVN account to view or contribute to the Kepler source.  

 

Individuals can join the kepler-dev mailing list to interact with the rest of the development team or the 
kepler-users mailing list to request and/or exchange user support. The current list of subscribers is available 
only to list members and can be viewed (after subscription) at the mailing list info page.  

 
Many of the Kepler developers use IRC to chat on a daily basis. We use the ά#keplerέ channel on 
irc.ecoinformatics.org:6667 for our discussions. More details on how to use IRC can be found on the SEEK 
IRC page. 

 
The code for Kepler is managed in an SVN repository.  Read-only access is open for all.  If you need to write 
to the SVN repository, please visit https://kepler-project.org/developers for instructions.  You can use any 
SVN client to access the Kepler repository.    

 

To check out and build the Kepler source code, you will need to have Java 7 or later, Ant 1.8.2 or later, and 
SVN 1.6 or later.  For development with Eclipse, these have been tested with Eclipse Ganymede and SVN 
1.6, with Subclipse 1.4.7.  

 

DOWNLOADING THE BUILD 
 

To download the latest version of the build from the repository, you will want to create a new directory and 
then execute the svn checkout (co) command, as in the following example. 

 

mkdir <modules.dir>  

cd < modules. dir>  

svn co https://code.kepler - project.org/kepler/trunk/modules/build - area  

cd build - area  

http://www.kepler-project.org/users/projects-using-kepler-1/kepler-core/
https://projects.ecoinformatics.org/ecoinfo/projects/kepler-12/issues
http://lists.nceas.ucsb.edu/kepler/mailman/listinfo/kepler-dev
http://lists.nceas.ucsb.edu/kepler/mailman/listinfo/kepler-users
http://seek.ecoinformatics.org/Wiki.jsp?page=IRCChannels
http://seek.ecoinformatics.org/Wiki.jsp?page=IRCChannels
https://kepler-project.org/developers
http://www.onlamp.com/pub/a/onlamp/2005/03/10/svn_uis.html
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<modules.dir> is the name of the directory where the build will be stored, as well as the modules you will 
be working on.  A good name for this folder might be something like kepler.modules. 

 

RETRIEVING KEPLER AND PTOLEMY 
 
Now that the build system has been downloaded, you will use the build system to retrieve Kepler and 
Ptolemy. 

 

First, you need to decide whether you would like to work with the latest, likely unstable development 
ǾŜǊǎƛƻƴ ƻŦ YŜǇƭŜǊ όǊŜŦŜǊǊŜŘ ǘƻ ŀǎ ǘƘŜ άǘǊǳƴƪέ ƻŦ YŜǇƭŜǊύΣ ƻǊ ǿƘŜǘƘŜǊ ȅƻǳ ǿƻǳƭŘ ƭƛƪŜ ǘƻ ǿƻǊƪ ǿƛǘƘ ŀƴ ƻŦŦƛŎƛŀƭ 
stable release, such as 2.5.0. 

 

To work from the trunk, issue the following command: 

 

ant change - to ïDsuite= Kepler  

 
To retrieve Kepler version 2.5.0: 

 

ant change - to ïDsuite=kepler - 2.5 .0  

 
SomŜ ŜȄǇƭŀƴŀǘƛƻƴ ƻŦ ǿƘŀǘ ǘƘŜ Ψant change-toΩ command is doing: 

 

What is actually first retrieved is something known as a suite. A suite contains information on where to 
retrieve the desired versions of Kepler and Ptolemy. This is used by the system to retrieve the appropriate 
versions of Kepler and Ptolemy. 

 

By default, when you type Ψant get -Dsuite=keplerΩ, you are making a request for a particular suite named 
άƪŜǇƭŜǊέΣ ǿƘƛŎƘ Ƙŀǎ ƛƴformation on how to download Kepler and Ptolemy. 

 

A final note: when you do Ψant get -Dsuite=<suite.name>ΩΣ you retrieve not only the suite, but all the 
modules that are associated with the suite as well. If you want to retrieve a single module instead of a suite 
of modules, type Ψant get -Dmodule=<module.name>Ω instead. 

 

NOTE: 
 

If you are behind a firewall and do not have access to port 22 and you are working off the trunk, then the 
download of Ptolemy will fail when you execute the Ψant change-to -Dsuite=keplerΩ command. In this case, 
you must download Ptolemy manually using the following command: 

 

svn co https://source.eecs.berkeley.edu/svn/chess/ptII/trunk <kepler.modules>/ptolemy  
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RUNNING KEPLER 
 
Now that you have downloaded the Kepler Build System and have used it to retrieve the Kepler version that 
interests you, you are ready to run.  Just type: 

 

ant run  

 

Note that it would be possible for a new user to get started without having to enter a command between 
get and run by chaining these commands in ant.  So, for example, if you wanted to download and run Kepler 
from the trunk all in one command, you could type: 

 

ant change - to ïDmodule=kepler run  

 

1.5.1 USING ECLIPSE 
 

See Kepler and Eclipse for more detailed instructions. However, in most cases, these instructions should be 
adequate. 

1. Type ant eclipse. 
2. Open Eclipse in a new or existing workspace. 
3. Choose File->Import... Under the General folder, choose Existing Projects into Workspace. Click 

Next. 
4. Click Browse right next to the Select root directory: field. Go to and select the <module.dir> 

directory where you saved the build and downloaded your modules. Click Choose. 
5. The projects that were generated will be automatically detected by Eclipse. Click on Finish. 
6. KarDoclet.java uses doclet code from tools.jar.  If you are using Java 7 on a non-Mac OS X 

machine, you will need to add tools.jar to the list of external jars: 
Windows -> Preferences -> Java -> Installed JREs 
Select the default JRE -> Edit -> Add External Jars -> [Path to JDK]/lib/tools.jar 

If you have the Subversive Eclipse plugin installed, you can select the newly generated projects, right click 
ƻƴ ǘƘŜƳΣ ŎƘƻƻǎŜ ά{ƘŀǊŜ tǊƻƧŜŎǘǎέΣ ŀƴŘ Ŧƻƭƭƻǿ ǘƘŜ ƛƴǎǘǊǳŎǘƛƻƴǎ ƛƴ ǘƘŜ ǿƛȊŀǊŘ ǘƻ ǎŜǘ ǳǇ ǘƘŜ ŎƻƴƴŜŎǘƛƻƴ ǘƻ ǘƘŜ 
Kepler repository (https://code.kepler-project.org/code/kepler/).  Repeat the process for the ptolemy 
project using the Ptolemy repository (svn://source.eecs.berkeley.edu/chess/ptII/). 

If you have the Subversive plugin installed, see Updating the local copy of the Kepler sources. 

To run Kepler, create a new Java Application Run Configuration: with project: loader, Main class: 
org.kepler.Kepler 

These instructions and further reference details, including how to run a workflow from the command line 
and setting system properties, can be found at: Kepler Build System Instructions and Overview. 

 

1.5.2 CONTRIBUTING TO KEPLER 
 

In order to contribute directly to Kepler, one must use a named account. This enables the user to make 
changes to the web site or the SVN repositories.  In general, people with write-access should only make 

https://kepler-project.org/developers/reference/kepler-and-eclipse
http://www.eclipse.org/subversive/
https://code.kepler-project.org/code/kepler/
https://code.kepler-project.org/code/kepler/
https://source.eecs.berkeley.edu/svn/chess/ptII/
https://kepler-project.org/developers/reference/kepler-and-eclipse#10-updating-the-local
https://kepler-project.org/developers/teams/build/documentation/build-system-instructions#downloading-the-build
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changes to modules with which they are directly involved or that they have discussed with the relevant 
Infrastructure and Development Teams.  Please be sure you have contacted the appropriate Team(s) before 
you request an account. 

 

To request a named account, send an email to pmc@ecoinformatics.org with your name, association, and 
a brief description of your project needs. 

 

1.6 REPORTING BUGS 
 

The Kepler project uses Redmine for reporting bugs as well as for sharing future development plans. Please 
register yourself by creating a new account to participate in future plans, bug reports, and updates.  

Redmine is one example of a class of programs called άDefect Tracking Systemsέ or, more commonly, άBug-
Tracking Systemsέ. Defect Tracking Systems allow individual or groups of developers to keep track of 
outstanding bugs in their product effectively.  

 

1.7 FURTHER READING 
 

As part of the outreach effort for Kepler, we have produced a variety of documents and publications.  
Publications of interest include: 

¶ Scientific Workflow Management and the Kepler System, B. Ludäscher, I. Altintas, C. Berkley, D. 
Higgins, E. Jaeger-Frank, M. Jones, E. Lee, J. Tao, Y. Zhao, Concurrency and Computation: Practice 
& Experience, 18(10), pp. 1039-1065, 2006.  

Additional publications are listed on the Kepler web site at http://kepler-project.org. 

Independent publications of the collaborating projects can be reached at their main websites: SEEK, 
SDMCenter-SPA, KBIS-SPA, Ptolemy, GEON, bioKepler, and CAMERA.

mailto:pmc@ecoinformatics.org
https://projects.ecoinformatics.org/ecoinfo/projects/kepler-12/issues?set_filter=1
https://identity.nceas.ucsb.edu/identity/cgi-bin/ldapweb.cgi?cfg=account
http://www.sdsc.edu/~ludaesch/Paper/kepler-swf.pdf
http://kepler-project.org/
http://seek.ecoinformatics.org/Wiki.jsp?page=SEEKDocuments
http://sdm.lbl.gov/sdmcenter/
http://kbi.sdsc.edu/
http://ptolemy.eecs.berkeley.edu/
http://www.geongrid.org/
http://www.biokepler.org/publications
http://camera.calit2.net/
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2 INSTALLING AND RUNNING KEPLER 
 

2.1 SYSTEM REQUIREMENTS 
 

Recommended system requirements for Kepler: 

 

¶ 300 MB of disk space  

¶ 512 MB of RAM minimum, 1 GB or more recommended 

¶ 2 GHz CPU minimum 

¶ Java 1.7 

¶ Network connection (optional). Although a connection is not required to run Kepler, many 
workflows require a connection to access networked resources. 

¶ R software (optional). R is a language and environment for statistical computing and graphics, and 
it is required for some common Kepler functionality. 

 

Java 1.7 or later is required. It can be obtained from your system administrator or online at: 
http://www.oracle.com/technetwork/java/javase/downloads/index.html. 

 

Kepler has many actors that utilize R, so installing R is recommended: http://www.r -project.org/. 

 

2.2 INSTALLING KEPLER 
 

Kepler is an open-source, cross-platform software program that can run on Windows, Macintosh, or Linux-
based platforms. Instructions for each platform are contained in the following sections. 

 

2.2.1 INSTALLING ON WINDOWS 
 
Follow these steps to download and install Kepler for Windows.  

 

Java 1.7 or later is required. It can be obtained from your system administrator or online at: 
http://www.oracle.com/technetwork/java/javase/downloads/index.html. 

 

Kepler has many actors that utilize R, so installing R is recommended: http://www.r -project.org/. 

 

1. Click the following link: https://kepler-project.org/users/downloads and select the Windows 
installer. 
 

2. Save the install file to your computer. 
  

3. Double-click the install file to open the install wizard. We recommend that you quit all programs 
before continuing with the installation. You can cancel the installation at any point via the Quit 

http://www.oracle.com/technetwork/java/javase/downloads/index.html
http://www.r-project.org/
http://www.oracle.com/technetwork/java/javase/downloads/index.html
http://www.r-project.org/
https://kepler-project.org/users/downloads
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button in the lower right corner of the installer. To proceed with the installation, click the Next 
button. 

 

4. Click the Next button. An information screen containing notes about the application appears. Click 
Next once you have read through the information to select an installation path. By default, the 
software will be installed in C:\Program Files\Kepler-x.y. The installer will create the target 
directory if it does not yet exist. If the directory already exists, the installer will confirm the location 
before possibly overwriting an existing version. 

 

5. Choose the packs to install. Once you have selected an installation, click the Next button. 
 

6. The Kepler installer displays a status bar as the installation progresses. If Kepler has previously 
been installed on the system, the installer will overwrite any existing cache files. 

 

Once the installation is complete, a confirmation screen opens. An 
uninstaller program is also created in the installation location. A 
Kepler shortcut icon will appear on your desktop.  

 

2.2.3 INSTALLING ON MACINTOSH 
 

The Mac installer will install the Kepler application on your system. Java is included as part of the Mac OSX 
operating system, so it need not be installed. 

 

Kepler has many actors that utilize R, so installing R is recommended: http://www.r -project.org/. 

 

 Follow these steps to download and install Kepler for Macintosh systems: 

 

1. Click the following link: https://kepler-project.org/users/downloads and select the Mac install file. 
2. Save the install file to your computer.  
3. Double-click the install icon that appears on your desktop when the extraction is complete.  
4. Follow the steps presented in the install wizard to complete the Kepler installation process. 
 

A Kepler icon is created under /Applications/Kepler-x.y. The icon can be dragged and dropped to the 
desktop or the dock if desired. 

 

2.2.4 INSTALLING ON LINUX 
 

The Linux installer will install the Kepler application.  

 

Java 1.7 or later is required. It can be obtained from your system administrator or online at: 
http://www.oracle.com/technetwork/java/javase/downloads/index.html. 

 

http://www.r-project.org/
https://kepler-project.org/users/downloads
http://www.oracle.com/technetwork/java/javase/downloads/index.html
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Kepler has many actors that utilize R, so installing R is recommended: http://www.r -project.org/. 

 

Follow these steps to download and install Kepler for Linux: 

 

1. Click the following link: https://kepler-project.org/users/downloads and select the Linux install file. 
2. Save the install file to your computer 
3. Double-click the install file to open the install wizard. If double-ŎƭƛŎƪƛƴƎ ǘƘŜ ƛƴǎǘŀƭƭ ŦƛƭŜ ŘƻŜǎƴΩǘ ǿƻǊƪ 

on your system, you may run the command java ïjar installer - file - name in a 
terminal to open the install wizard. We recommend that you quit all programs before continuing 
with the installation.  

4. The Kepler installer displays a status bar as the installation progresses. If Kepler has previously 
been installed on the system, the installer will overwrite any existing cache files. 

 

2.3 STARTING KEPLER 
 

To start Kepler on a PC, double-click the Kepler shortcut icon on the desktop. Kepler can also be started 
from the Start menu. Navigate to Start menu > All Programs, and select άKeplerέ to start the application.  
On a Mac, the Kepler icon is created under Applications/Kepler-x.y. The icon can be dragged and dropped 
to the desktop or the dock if desired. 

 

To start Kepler on a Linux machine, use the following steps: 

 

1. Open a shell window. On some Linux systems, a shell can be opened by right-clicking anywhere on 
the desktop and selecting άOpen Terminalέ. Speak to your system administrator if you need 
information about your system. 

2. Navigate to the directory in which Kepler is installed. To change the directory, use the cd  command 

(e.g., cd  directory_name).  

3. Type ./kepler.sh  to run the application. 
 

The main Kepler application window opens (Figure 2.1).  From this window, you can access and run existing 
scientific workflows and/or create your own custom scientific workflow.  Each time you open an existing 
workflow or create a new workflow, a new application window opens.  Multiple windows allow you to work 
on several workflows simultaneously and compare, copy, and paste components between workflows.   

 

To start Kepler from the command line (optionally loading a workflow), use the following command: 

 

kepler.sh  [ - nosplash] [workflow.xml | workflow.kar]  

 

- nosplash  start withou t showing splash screen.  

 

On Windows, the executable is kepler .bat  instead of kepler .sh . 

 

To run a workflow XML from the command line: 

 

http://www.r-project.org/
https://kepler-project.org/users/downloads
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kepler - runwf [ - nogui | - redirectgui dir] [ - nocache]  [ - noilwc] [ - param1 

value1 ...] workflow.xml  

 

- nogui  r un without GUI  support.  

- nocache  run without kepler cache.  

- noilwc  run without incrementing LSIDs when the  workflow changes.  

- redirectgui dir  redirect the contents of GUI actors to  the specified 

directory.  

 

To run a workflow KAR from the command line: 

 

kepler.sh - runkar  [ - nogui | - redirectgui dir] [ - force] [ - param1 value1 

...] workflow.kar  

 

- force              attempt to run ignoring missing module  dependencies.  

- nogui              run without GUI support.  

- redirectgui dir    redirect the contents of GUI actors to  the sp ecified 

directory.  

 

You can specify the values of workflow parameters: 

 

kepler .sh  - runwf - x 4 - y "foo"  workflow.xml  

 

The above command runs άworkflow.xmlέ, setting the parameters x = 4 and y = "foo". The full command-
line usage for the Kepler executable can be found by running: 

 

kepler .sh  ïh 

 

2.4 THE USER INTERFACE 
 

{ŎƛŜƴǘƛŦƛŎ ǿƻǊƪŦƭƻǿǎ ŀǊŜ ŜŘƛǘŜŘ ŀƴŘ ōǳƛƭǘ ƛƴ YŜǇƭŜǊΩǎ Ŝŀǎƛƭȅ ƴŀǾƛƎŀǘŜŘΣ ŘǊŀƎ-and-drop interface. The major 
sections of the Kepler application window (Figure 2.1) consist of the following: 

 

¶ Menu bar: provides access to all Kepler functions.  

¶ Toolbar: provides access to the most commonly used Kepler functions. 

¶ Components, Data Access, and Outline area: consists of a Components tab, a Data tab, and an 
Outline tab.   The Components and Data tabs each contain a search function and display the library 
of available components and/or search results. The Outline tab displays an outline of components 
that are in your current workflow. 

¶ Workflow canvas: provides space for displaying and creating workflows. 

¶ Navigation area: displays the full workflow. Click a section of the workflow displayed in the 
Navigation area to select and display that section on the Workflow canvas. 

 

Each of these interface areas is described in more detail in the following sections. 
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FIGURE 1.1: EMPTY KEPLER WINDOW WITH MAJOR SECTIONS ANNOTATED. 

 

2.4.1 MENU BAR 
 

Running horizontally across the top of the Kepler application, the Menu bar contains the seven Kepler 
menus: File, Edit, View, Workflow, Tools, Window, and Help. Common menu item functions, such as Copy, 
Paste and Delete, are assigned keyboard shortcuts, which can also be used to access the functionality. These 
shortcuts, when relevant, appear to the right of each menu item. 

 

The following sections describe each menu in greater detail. 

 

2.4.1.1 FILE MENU  
 

The File menu, which is the first menu in the Menu bar, contains commands for handling files and for exiting 
the application: New Workflow, Open, Recent Files, Close, Save, Save As, Export As, Print, and Exit. 

 

New Workflow: open a new application window. Select Blank, FSM, or Modal Model. For more information 
about FSM and Modal Models, please see the Ptolemy documentation. 

 

http://www.eecs.berkeley.edu/Pubs/TechRpts/2007/EECS-2007-7.pdf
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hǇŜƴΧ: open a workflow saved in a KAR (Kepler Archive format) or XML (.xml or .moml) onto the Workflow 
canvas. Text-based filesτtext (.txt) or HTML (.html), for exampleτwill be opened in a viewing window. 

 

Recent Files: list and open recent up to 10 workflows (KAR or XML format) that were successfully opened 
before. 

 

Save: save the workflow displayed on the Workflow canvas and any other related files into a KAR (Kepler 
Archive format) file. 

 

Save As: save the current workflow to a new KAR file. 

 

Export: save the current workflow as MoML (Modeling Markup Language) XML, to a static image (GIF or 
PNG), or to an interactive HTML representation. 

 

Print: print the graphical representation of the workflow. A page setup window is used to set the paper 
size, source, margins, and orientation. 

 
Close: close the current Workflow canvas. 

 

Exit: exit the Kepler application. If a workflow is open, a dialog box will prompt a user to save or discard 
changes. Users can also cancel and return to the main application window. 

 

2.4.1.2 EDIT MENU  
 

Edit menu items are primarily used to modify the Workflow canvas, allowing users to cut, copy, and paste 
selected entities. In addition, Undo and Redo commands can be used to modify the history of workflow 
changes. 

 

Undo: (Ctrl+Z) Undo the most recent change. The άUndoέ command can be performed multiple times to 
undo the history of workflow changes. The size of the history buffer  
is limited only by available RAM. 

 

Redo: (Ctrl+Y) Redo the most recent change. ¢ƘŜ άwŜŘƻέ ŎƻƳƳŀƴŘ Ŏŀƴ ōŜ ǇŜǊŦƻǊƳŜŘ ƳǳƭǘƛǇƭŜ ǘƛƳŜǎ ǘƻ 
redo the history of workflow changes. 

 

Cut: (Ctrl+X) Cut the selected entities. 

 

Copy: (Ctrl+C) Copy the selected entities to the clipboard. 

 

Paste: (Ctrl+V)  Paste the contents of the clipboard to the Workflow canvas. 

 

Delete: (Ctrl+X or Delete key) Delete the selected entities.  
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2.4.1.3 VIEW MENU  
 

View menu items control how the workflow appears on the Workflow canvas. Zoom items are also available 
via the Toolbar. 

 

Zoom Reset (Ctrl+Equals): Reset the view of the Workflow canvas to the default settings. 

 

Zoom In (Ctrl+Shift+Equals): Magnify the Workflow canvas for a more close-up view. Kepler provides fixed 
levels of zoom. 

 

Zoom Out (Ctrl+Minus): Pull back for a more distant view of the Workflow canvas. Kepler provides fixed 
levels of zoom. 

 

Zoom Fit (Ctrl+Shift+Minus): Display the current workflow in its entirety on the Workflow canvas. 

 

Automate Layout (Ctrl+T): Make a workflow more readable by automatically configuring actor locations. 

 

XML View: View the current workflow in XML mode. The workflow MoML (i.e., XML) will be displayed in a 
viewing window. 

 

2.4.1.4 WORKFLOW  
 

Workflow menu items are used to run and modify open workflows.  

 

Runtime Window: The Runtime Window command opens a Run window, which allows users to adjust 
workflow parameters and run, pause, resume, or stop workflow execution. Workflow results are displayed 
in the window as well. 

 

Add Relation: Add a Relation to the Workflow canvas. RelationsΣ ǿƘƛŎƘ ƳƛƎƘǘ ŀƭǎƻ ōŜ ŎŀƭƭŜŘ άŎƻƴƴŜŎǘƻǊǎέΣ 
allow actors to άbranchέ output to multiple places. For more information about Relations, see Section 3.2.7. 

 

Add Port: Add a port to the Workflow canvas. Select Input, Output, Input/Output, Input Multiport, Output 
Multiport, or Input/Output Multiport. For more information about ports, see Section 3.2.4. 

 

2.4.1.5 TOOLS  
 

The Tools menu contains a number of useful tools that are used to build and troubleshoot workflows. 
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Animate at Runtime: Select this menu item to highlight the actor that is currently processing as the 
workflow is run. The active actors will be denoted with a red highlight. Note: This command is only relevant 
when an SDF Director is used.  

 

Listen to Director: Open a viewing window that displayǎ ǘƘŜ 5ƛǊŜŎǘƻǊΩǎ ŀŎǘƛǾƛǘȅΣ ƴƻǘƛƴƎ ǿƘŜƴ ŜŀŎƘ ŀŎǘƻǊ ƛǎ 
preinitialized, initialized, prefired, iterated, and wrapped up.  

 

Create Composite Actor: Create a new composite actor on the Workflow canvas. For more information 
about composite actors, please see Section 3.2.3. 

 

Expression Evaluator: Open an Expression Evaluation window used to evaluate any Kepler expression. For 
more information about the expression language, see the Ptolemy documentation.  

 

Instantiate Component: Open the designated component on the Workflow canvas. Components can be 
identified via class name (e.g., ptolemy.actor.lib.Ramp) or via a URL. Use this menu command to easily 
access components that are not included in the Kepler component tree (e.g., the DDF Director or Ptolemy 
actors that are not included in the default Kepler library). 

 

Instantiate Attribute: Open the designated attribute on the Workflow canvas. Attributes are identified by 
class name (e.g., ptolemy.vergil.kernel.attributes.EllipseAttribute).  

 

Check System Settings: Open a window containing system settings. 

 

Ecogrid Authentication: Provide log in credentials or log out after using 
features in Kepler that require authentication (e.g., an authenticated data search for the KNB (Earthgrid) or 
uploading actors to the Kepler actor library). 

 

Preferences: Set various Kepler preferences, including local and remote directories used to find 
components for the component library and services used for data sources. 

 

Text Editor: Open a simple text editor used to create, edit, and save text files. 

 

Module Manager: View modules in the current suite, load and save module configurations, view 
downloaded modules, and view available modules, and switch to a different module configuration. For 
more information on the module manager, see Chapter 12. 

 

JVM Memory Settings: Adjust how much memory is allocated to Kepler. If your computer has available 
RAM, you may want to allocate more memory to Kepler by increasing the Max Memory setting. This may 
improve performance. 

 

2.4.1.6 WINDOW  
 

Access the Runtime Window via the menu option. 

http://ptolemy.eecs.berkeley.edu/~eal/ee225a/lab/expression.pdf
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2.4.1.7 HELP  
 
The Help menu contains information about the current version of Kepler as well as links to useful help 
documentation. 

 

About: Open a window containing the current Kepler version number. 

 

Kepler Documentation: An index of useful Kepler documents. 

 

Modules Documentation: An index of documentation for the installed modules. 

 

2.4.2 TOOLBAR 
 

The Kepler Toolbar contains the most commonly used Kepler functions (Figure 2.2). The Toolbar can be 
dragged and dropped to a convenient screen location. Closing the Toolbar returns it to the default position 
beneath the Menu bar and above the Workflow canvas. 

 

The Toolbar consists of three main sections: View, Run, and Ports, discussed in more detail below.  

 

FIGURE 2.2: THE KEPLER TOOLBAR. 

 

2.4.2.1 VIEW TOOLS 
 

View tools (Table 2.1) are used to zoom in, reset, fit, and zoom out the workflow on the Workflow canvas: 

 

 

Zoom In: Magnify the Workflow canvas for a more close-up view. Kepler provides fixed 
levels of zoom. 

 

 

Zoom Reset: Reset the view of the Workflow canvas to the default settings. 
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Zoom Fit: Display the current workflow in its entirety on the Workflow canvas. 

 

 

Zoom Out: Pull back for a more distant view of the Workflow canvas. Kepler provides fixed 
levels of zoom. 

 

TABLE 2.1 VIEW TOOLS 

 

2.4.2.2 RUN TOOLS 
 

Run tools (Table 2.2) are used to run, pause, and stop the workflow. 

 

 

Run: Run the workflow. The button will have an orange highlight when the workflow is 
running. 

 

Pause: Pause the workflow. The button will have an orange highlight when the workflow 
is paused. To resume the workflow, click the Run button. 

 

 

Stop: Stop workflow execution. The button will have an orange highlight when the 
workflow is stopped. To restart the workflow, click the Run button.  

 

TABLE 2.2: RUN TOOLS 

 

2.4.2.3 PORT TOOLS 
 

Port tools (Table 2.3) are used to add Relations or Ports to workflows: 

  

 

Input Port:  Add a single input port. A single input port can be connected to only a single 
channel of data. Single ports are designated with a dark triangle on the Workflow canvas. 

 

 

 

Output Port: Add a single output port. A single output port can emit only a single channel 
of data. Single ports are designated with a dark triangle on the Workflow canvas. 

 

 

Input/Output Port: Add a bi-directional port, which can receive or send a single channel 
of data. 

 

 

Multiple Input Port: Add a multiple input port. A multiple input port can be connected to 
multiple channels of data. Multiple ports are designated with a hollow triangle on the 
Workflow canvas. 
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Multiple Output Port: Add a multiple output port. A multiple output port can emit 
multiple channels of data. Multiple ports are designated with a hollow triangle on the 
Workflow canvas. 

 

 

Multiple Input/Output Port: Add a multiple input/output port. A multiple input/output 
port can receive or send multiple channels of data. Multiple ports are designated with a 
hollow triangle on the Workflow canvas. 

 

Relation: Add a Relation. Relations άōǊŀƴŎƘέ ŀ Řŀǘŀ Ŧƭƻǿ so that data can be sent to 
multiple places in the workflow. 

TABLE 2.3: PORT TOOLS 

 

2.4.3 COMPONENTS, DATA ACCESS, AND OUTLINE AREAS 
 

The Components and Data Access area contains a library of workflow components (e.g., directors and 
actors, under the Components tab) and a search mechanism for locating those components, as well as data 
sets (under the Data tab). The Outline area displays an outline tree of the components that are being used 
in the current workflow.  When the application is first opened, the Components tab is displayed. 

 

2.4.3.1 COMPONENTS TAB 
 

Kepler comes standard with over 350 components that are stored on the local machine and can be used to 
create an innumerable number of workflows with a variety of analytic functions. The default set of Kepler 
processing components is displayed under the Components tab in the Components and Data Access area. 
Users can easily add new components or modify existing components. See Chapter 5 for more information 
about adding components to the local library. 

 

Components in Kepler are arranged in three high-level categorizations: Components, Projects, and Statistics 
(Table 2.4). Any given component can be classified in multiple categories, appearing in multiple places in 
the component tree.  

 

Category Description 

Components Contains a standard library of all components, arranged by 
function. 

Projects  Contains a library of project-specific components (e.g., SEEK 
or CIPRes). 

Statistics  Contains a library of components for use in statistical 
analysis. 

TABLE 2.4: COMPONENT CATEGORIES IN KEPLER 

 

Browse for components by clicking through the component trees, or use the search function at the top of 
the Components tab to find a specific component.  

 

To search for components: 

http://seek.ecoinformatics.org/
http://www.phylo.org/
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1. In the Components and Data Access area to the left of the Workflow canvas, select the 
Components tab.   

2. Type in the desired search string όŜΦƎΦΣ άCƛƭŜ wŜŀŘŜǊέύ. 
3. Click the Search button. The search results are displayed in the Components and Data Access area, 

replacing the default list of components. You may notice multiple instances of the same 
component. Because components are arranged by category, the same component may appear in 
multiple places in the search results. 

4. To use one or more components in a workflow, simply drag the desired components to the 
Workflow canvas. 

5. To clear the search results and re-display the complete component library, click the Cancel button. 
 

NOTE:  If you know the name of a component and its location in the Component library, you can navigate 
to it directly and then drag it to the Workflow canvas.   

 

2.4.3.2 DATA TAB 
 

Via its search capabilities, Kepler provides access to data stored remotely on the EarthGrid, which contains 
a wide collection of ecological and geographical resources. Select the Data tab (Figure 2.3) in the 
Components and Data Access area to find and retrieve remote data sets. 
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FIGURE 2.3: THE DATA TAB. A SEARCH HAS BEEN PERFORMED TO LOCATE "DATOS METEOROLOGICOS", A DATA SET STORED ON 

THE EARTHGRID. 

 

To search for data on the EarthGrid through Kepler: 

 

1. In the Components and Data Access area, select the Data tab. 
2. Click the Sources button and select the services to search (deselecting unnecessary sources 

decreases search time). 
3. Type in the desired search string (e.g., Datos Meteorologicos). Make sure that the search string is 

spelled correctly. (You can also enter just part of the entire string ς ŜΦƎΦΣ ά5ŀǘƻǎέύΦ LŦ ǘƘŜ ǎŜŀǊŎƘ 
requires authentication (e.g., searches on the KNB Authenticated Query source), use the Tools > 
Ecogrid Authentication menu option to specify credentials. 

4. Click the Search button. The search may take several moments. When the search is complete, a 
list of search results (i.e., Data actors) will be displayed in the Components and Data Access area. 

5. To use one or more data actors in a workflow, simply drag the desired actors to the Workflow 
canvas. 

 

When a data set is dragged from the Data tab to the Workflow canvas, Kepler downloads the data from the 
remote source and stores it in the Kepler cache where it can be accessed by the workflow or easily 
previewed. The cache (i.e.., the ά.kepler έ directory) is in the userΩs HOME directory, which is the default 
working directory whenever one first opens a Command Window (on Windows platforms) or a terminal 
window (on Mac or Linux). On Mac and Linux systemǎΣ ǘƘŜ ŎƻƳƳŀƴŘ άcd ~ έ will change directories to the 
home directory. Once data is stored in the cache, Kepler will automatically access the local copy rather than 
re-download the data. If you would prefer to re-download the data, and you are using an EML2Dataset 
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actor, select the Check for latest version  parameter to override the default behavior. See 
Chapter 6 for more information. 

 

Information about downloaded data can be revealed in three ways: (1) on the Workflow canvas, roll over 
the 5ŀǘŀ ŀŎǘƻǊΩǎ output ports to reveal a tooltip containing the name and type of data or (2) right-click the 
Data actor and select Get Metadata to open a window that contains more information about the data set 
(Figure 2.4) or (3) preview the data set by right-clicking the data actor and selecting Preview from the drop-
down menu (Figure 2.6). 

 

 
FIGURE 2.4: METADATA FOR THE DATOS METEOROLOGICOS DATA SET. 
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FIGURE 2.5:  PREVIEWING A DATA SET. 

 

Downloaded data can be output in a variety of formats. See Chapter 6 for more information. 

 

The EarthGrid currently interfaces with KNB Metacat database. The Knowledge Network for Biocomplexity 
(KNB) is a national network intended to facilitate ecological and environmental research on biocomplexity. 
It enables the efficient discovery, access, interpretation, integration, and analysis of many kinds of 
ecological data from a highly distributed set of field stations, laboratories, research sites, and individual 
researchers.10 

 

To configure a data search to search a subset of the EarthGrid, click the Sources button from the Data tab. 
Select the sources to be searched and the type of documents to be retrieved (Figure 2.6) Each service 
requires that at least one corresponding document type is selected (e.g., the KNB Metacat EcoGrid 
QueryInterface service requires that either Ecological Metadata Language 2.0.0, 2.0.1, or 2.1.0 is selected). 
If you try to άdeselectέ all of the relevant document types, the service is automatically deselected as well. 
The document types (e.g., Ecological Metadata Language 2.0.0) refer to the metadata specification used by 
the data sets. For more information about metadata, please see Chapter 6. 

 

                                                                 
10 Knowledge Network for Biocomplexity (KNB) website, http://knb.ecoinformatics.org. 
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